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All Rights Reserved.
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FCC Information
FCC ID:
This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following
measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.
Consult the dealer or an experienced radio/TV technician for help.
Shielded cables and I/O cards must be used for this equipment to comply with the relevant FCC
regulations. Changes or modifications not expressly approved in writing by SoftLab-NSK Ltd. may
void the user’s authority to operate this equipment.
Limited Warranty
Our company warrants this product against defects in materials and workmanship for a period of
one year from the date of purchase. During the warranty period, products determined by us to be
defective in form or function will be repaired or replaced at our option, at no charge. This warranty
does not apply if the product has been damaged by accident, abuse, misuse, or as a result of service
or modification other than by us.
This warranty is in lieu of any other warranty expressed or implied. In no event shall we be held
liable for incidental or consequential damages, such as lost revenue or lost business opportunities
arising from the purchase of this product.
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Introduction
The SLTelephone application is designed to display telephone
poll results in real time on air in the form of dynamically
updated picture.
The application is used for organizing of telephone surveys and
for displaying its results in titles.
The application is a program option for the ForwardT products.

The application provides the ability to deal with calls received
by 8 telephone lines. Information on calls number can be
received in different ways:
●● via dataphone adapter Liner-8 plugged to the PC;
●● via XML file from specific Web site (HTTP or FTP);
●● via XML file located on local disc;
●● via buttons of the main application window manually.
It is possible to receive calls in the automatic and manual
modes simultaneously.
The telephone poll broadcast design is set by user.
This document contains information on application specificities,
its interface and description of televote organizing procedure.
The SLTelephone application is supplied with a useful sample
that may help when learning how to work with the application.
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Configuring Parameters

The SLTelephone application is used with other application
from ForwardT Software package: Forward Titling,
FDTitle Designer, FDOnAir.

General Information on the Application
1. Purpose, Scope of Application
The SLTelephone application is designed to create and
periodically update a picture with televote results. The
application is used for organizing of telephone surveys and for
displaying its results in titles.

2. Principle of Operation
When the application is configured it should be switched to the
voting mode. The application collects voting data and generates
a picture automatically in this mode. Also, the SLTelephone
implements the following in voting mode periodically:
1. Reads information on current number of votes received
by telephone lines. Data comes from specified source, e.g.
dataphone adapter LinerR-8 or it can be entered manually.
2. Calculates total number of votes according to answers.
3. Presents vote results in differents forms:
●● in percent;
●● graphically in the form of a histogram.
4. Generates a picture based on calculated data.
5. Records generated picture to target graphic file.

1. '
2. '
...
8.

'

Liner-8/other source

Data

Periodically:
Reads data;
Calculates results;
Generates picture with text
and graphics with result;
Outputs created picture into
file.

Generated picture
Graphic file
(TGA file)

SLTelephone
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General Information

The SLTelephone application provides with a possibility to:
●● configure parameters of voting procedure;
●● adjust buttons functioning;
●● change a number of votes manually;
●● control beginning and finishing of data collecting and
picture generating;
The SLTelephone application automatically:
●● displays a procedure of televote in the main
application window.
●● collects data, calculates result and generates a picture;
●● keeps logging.

4. Input Data
The application generates target picture that is based on the
following input data:
●● information on the number of calls received by line
that can be received by the application:
●● directly from Liner-8 plugged to the PC;
●● via XML file from specified Web site or local PC;
●● by entering manually via buttons of the main
application window;
●● template of picture design, i.e. region stored in the
RGN file.

5. Output Data
Output data is a TGA file.
This is a picture that is updated periodically considering
number of votes. The picture displays actual information on
voting in any time.

6. Configured Parameters
Configure the following parameters to work with the
application:
●● service parameters that specify properties of the main
application window controls;
●● parameters of data collecting and picture generating:
how votes data is received, the name of a region file,
the name of an output file etc.
For configuring of application parameters settings file should be
created.
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3. Functional Capabilities

Software Use
1. General Scheme of Televote Results Displaying in Titles
The SLTelephone application is used along with the
applications from the ForwardT Software package.
The picture below represents how televote results are output on
air via the SLTelephone application.
1.

2.

...

8.

4

Liner-8 (dataphone
adapter)/other source

1

reads information
periodically
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'' '

2

SLTelephone
calculates voting updates a picture
periodically
results and
generates a picture

Graphic file that
is the task for
the Picture title
element

The Picture
title element

Air

Title project

FDOnAir

1. Broadcast controlling, overlaying titles over main signal
and outputting of data on air are implemented via the
FDOnAir application (1). Load title project in the FDOnAir
application to display titles.
2. Implement the following steps to display dynamically
updated information on televote in titles via the
SLTelephone application:
1. Include the Picture title element in your title project.
2. Specify TGA task file (2) for this title element. TGA file is
the output file of the SLTelephone application.
3. Launch the SLTelephone application (3) in voting
mode and start broadcasting in the FDOnAir application
simultaneously.
3. The SLTelephone application reads information from the
specified source (e.g. Liner-8 (4)) automatically. Then it
generates a picture and records it to graphic file. This
graphic file is the task for the Picture title element.
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2. Other Required Applications
The SLTelephone application is used along with other
applications from the ForwardT Software package. The table
below represents applications necessary for televote organazing.
Stage
Preparation

Broadcasting

Forward Titling

The application is used to create
region (RGN file) that is a picture
template.

FDTitle Designer

The application is used to create
a title project with necessarily
included Picture title element.

Any text editor

The application is used to create
a settings file.

FDOnAir

The application is used to create
a schedule of broadcasting.

Broadcasting control, titles
overlaying over the main
signal, output on air.

SLTelephone

Loading of settings file in the
application.

Receiving and calculating of
votes, generating a new picture
periodically and loading it
in TGA file. Everything is
implemented automatically.

3. General Workflow

Complete the following steps to output televote results on air
via the SLTelephone application. Complete steps 1–7 before
voting starts:
1. Create a template of the output picture (region) in the
Forward Titling application.
2. Create a settings file via any text editor.
3. Configure receiving of telephone calls.
4. Load settings file in the SLTelephone application and then
switch the application to the voting mode. The first picture
will be generated and recorded to graphic file. This file has
the name specified in the settings file.
5. Create title project including Picture title element via
TitleDesigner.
6. Specify graphic file created via the SLTelephone application
as the task for the Picture title element.
7. Implement the following configurations in the FDOnAir
application: create a schedule and load title project.
8. Launch the schedule in the FDOnAir application. In this
case the SLTelephone application must be in voting mode.
Receive calls in the specified way.
9. Picture with current voting results will be displayed and
updated periodically.
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Application Name

Displaying of Voting Data
1. Picture

Picture

Displaying of Voting Data

Information on voting results transmits into the picture that
is updated dynamically during broadcasting. Creating and
updating of the picture is implemented via the SLTelephone
application.

6
1

4
3

5

2

The following information connected with voting procedure can
be displayed on the picture:
1. Any text information. As a rule this is a kind of a basic
information necessary to carry out a survey:
●● question (1);
●● versions of answers and corresponding telephone
numbers (2).
2. Data on current results in numerical format:
●● total number of people who voted (3);
●● number of votes for every answer (4);
●● number of votes for every answer in percent from the
total number of votes (5).
3. Data on current results of voting presented graphically in
the form of a graph with votes distribution according to
answers versions (6).
Picture design, structure and form of picture elements are
configured via the template in advance.
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In our case we have a histogram that displays distribution of
votes according to answers. You may select among 2 ways of
normalization dealing with the SLTelephone application. These
ways differ in normalization factor:
●● normalization on total number of votes for all answers (1);
●● normalization on maximal value between all values (2) –
maximum (N_Var1, N_Var2, ..., Barsize),
where:
●● N_Var1, N_Var2, ... is the number of votes for the
answer with a corresponded number;
●● Barsize is the Barsize parameter value that is
specified in settings file in the General section.
The picture below displays 2 histograms with distribution of
votes using different types of normalization (initial data is the
same).
1

2
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2. Histogram

3. Template of Output Picture (RGN File)
The output picture of the SLTelephone application is based on
a picture template. The template is a region, i.e. a multilayer
picture created in the Forward Titling application. The region is
saved in the file with the rgn extension.
For more detail on the Forward Titling application, see
the ''ForwardTitling: Graphic Editor'' user's guide.

Configuring Parameters

The picture below represents a Forward Titling main window
with the region created for our sample.

Region must contain a specific set of text and graphic objects. A
list with the set of is given in the table below.
Specified objects in the region depend on what kind of
information should be displayed. Region may also contain any
other elements.
Correspondence between region objects and their values is
specified in settings file.
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Table 1.
N

Region objects

Object type

Quantity

Purpose

Name in the
example

1

Tex box

(text object)

1

The object is used to display a
text of question.

Question

The objects are used to display a
text of possible answers.

Answer1
Answer2
Answer3

2

–||–

Quantity is
specified according
to quantity of
answers, 3 in our
example.

3

–||–

–||–

The objects are used to display
telephone numbers.

Tel1
Tel2
Tel3

4

–||–

–||–

The objects are used to display
vote results, i.e. votes for
corresponded answer.

Value1
Value2
Value3

5

–||–

–||–

Percent1
The objects are used to display
voting results, number of votes for Percent2
a corresponded answer in percent. Percent3

6

–||–

1

7

Rectangle

(graphic
object)

Quantity is
specified according
to the number of
answers, there are
3 answers in our
example.

The object is used to display a
total number of votes.

All

The objects are used to display
distribution of answers according
to versions graphically (histogram
rectangles).

Bar1
Bar2
Bar3

Configuring Parameters

(see picture
below)

Bar1

Total

Question
Answer1

Value1
Telephone

Percent1
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Installation
Install ForwardT Software package, version not less than 5.0.0
and necessary updates of the version not less than 5.0.8 on PC
to install the SLTelephone application.
1. Start the ForwardT Plugins_Setup_xx_xx_xx.exe file located on
setup disc.
2. Welcome to the ForwardT Plugins Setup Wizard window appears.
Click Next (1) to continue.

1
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Installation

Application Installation

3. Select the SLTelephone files component (2) and click Next (3).

Installation

2

3

4. Click Install (4) to install the ForwardT Plugins Software in
the ~\Plugins folder, where ~ denotes a full path to the folder
where the ForwardT Software is installed.

4
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Registration

5. Click Finish (5) to complete the installation.

5

88

Important:

Reboot your PC after plugin installation.

Registration
This software requires registration. Appeal to the SoftLab-NSK
support to get registration key. Detailed information can be
received at:
http://www.softlab-nsk.com/forward/plugins.html
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Ways of Data Receiving

Information on number of calls may be received in several ways:
1. From Liner-8 plugged to local PC in automatic mode.
2. From statistics file created automatically and located on
specified site. Data is received via HTTP or FTP.
3. From statistics file created automatically and located on
local PC.
4. Manually via buttons of the main application window or
assigned shortcuts.
Only one automatic way of votes calculating can be used during
application session: Liner-8 or statistics file.
It is possible to use simultaneously automatic and manual ways
of telephone calls calculating.
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Ways of Data Receiving

Collecting of Vote Results

Dataphone Adapter Liner-8

Dataphone adapter Liner-8 is used for interactive voting. It is
produced under the Teleview brand. More information on this
issue can be found at www.teleview.ru.

Configuring Parameters

Liner-8 provides the ability to receive telephone calls by several
lines simultaneously and to input these results in PC. Liner-8
plays out specific audio message automatically for every
abonent.
1 – 8 lines can be connected to Liner-8 via special input
connectors located on back and front panels of this device.
Liner-8 and PC are plugged by USB port. The device will be
automatically detected by PC.
Plug adapter to PC with SLTelephone and install its drivers
correctly to work properly with Liner-8.

3

1

2

Appeal to the SoftLab-NSK support for more information on
Liner-8 and the SLTelephone application.
Additional information on adapter can be found at
www.okno-tv.ru.
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Statistics File
1. Purpose and Workflow

The name of this file is specified by user. The file can be located
on local PC or at specified site. Use HTTP or FTP to load data
from statistics file located at the site.
The SLTelephone application from time to time automatically
reads information from statistics file. For getting this
information specify path to the settings file (the FromUrl
parameter, General section) or its URL. Specify a period of
request to the statistics file via the Timeout parameter in
General section. Information will be upadated only when
changed statistics file is saved.

2. Structure of Statistics File
Statictics file contains data on number of calls. The file must
contain the following elements:
<SLTelephoneStatistics>
<line number=’’1’’ calls=’’NCalls_1’’ />
<line number=’’2’’ calls=’’NCalls_2’’ />
<line number=’’3’’ calls=’’NCalls_3’’ />
<line number=’’4’’ calls=’’NCalls_4’’ />
<line number=’’5’’ calls=’’NCalls_5’’ />
<line number=’’6’’ calls=’’NCalls_6’’ />
<line number=’’7’’ calls=’’NCalls_7’’ />
<line number=’’8’’ calls=’’NCalls_8’’ />
</SLTelephoneStatistics>,
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Statistics file is an ХML file that contain information on the
number of received calls by some time.

where:

●● <SLTelephoneStatistics>, </SLTelephoneStatistics>

and end tags;

are start

is the element with
a description of telephone line under the k number.
NCalls_k indicates a received number of calls on this
line by some time from the start of televoting.

●● <line number=’’k’’ calls=’’NCalls_k’’ />

88 Important: It is obligatory to include all indicated above elements (one copy
of each) in the file.

 Example:

Consider that the statistic.xml name is used for statistics file
intended for voting results exchanging.
Picture below represents this file opened with Notepad.
The content of the file indicates that 10 calls were received by
the first line, 15 by the second, 4 by the third etc. when the file
was opened.
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Statistics File

3. Example

Entering of Data Manually

Shortcuts can be assigned to any of the following commands:
●● to vary result for the version under the variant N on 1:
●● Variant N, + is adding of 1 vote;
●● Variant N, - is taking 1 vote away;
●● to vary result for the version under the N number
on several units (number of votes is configured in
the settings file via the CallsBigStep and CallsBigStepN
parameters in General):
●● Variant N, ++ is adding of several votes;
●● Variant N, -- is taking several votes away.
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Entering of Data Manually

Data can be entered manually via buttons of the main program
window. Also you may use keyboard shortcuts.

Procedure of Votes Calculating
1. General Information
Votes are calculated by the application automatically.
Information on votes number is received automatically or can
be entered manually.

2. Votes on One Telephone Line
Number of votes on the line and number of received calls can be
different.
The following formula is used to calculate votes:
where:

denotes number of votes on the line at the current
time;
●● NCalls_k denotes number of calls received by the
current time;
●● F_k denotes a specified line factor. Factors are
configured in settings file (in this case work with the
corresponded Factor parameter in the corresponding
Line section) or via elements of the main application
window. Factors can be changed when televoting is
being implemented.
●● N_k

For example, if factor is 1 the number of votes will be equal to
number of calls. If factor is 2 number of votes will be 2 times
more than number of calls.

3. Votes For Answers
Several telephone lines can be assigned to one answer. Votes
can be also added/removed manually via buttons of the main
application window.
The following formula is used to calculate votes for one variant:
N_Var=N_manually+N_k1+N_k2+...,

where:

denotes number of votes for answer at the
current time;
●● N_manually denotes number of votes for this answer
entered manually by the current time;
●● N_k1, N_k2 ... denotes number of votes on lines assigned
to the given answer at the moment.
●● N_Var
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Procedure of Votes Calculating

N_k=NCalls_k*F_k,

24
Procedure of Votes Calculating

General Information

Settings File

General Information
1. Name and Content of File
Settings file is a text file with the SLPhoneProj extension.
The file has SLTelephone application settings:
1. Service settings specify a type and location of log files and
properties of main application window control elements;
2. Settings for data collecting and picture generating:
●● general settings:
●● region file name;
●● TGA file name;
●● period of picture update;
●● parameters of histogram rectangles normalizing;
●● settings of decimal place;
●● data source settings:
●● specifying of data source (file name/URL or
telephone lines (1–8) plugged to the Liner-8);
●● parameters of telephone lines use;
●● substitution strings that are settings for specifying
a type and a content of output image elements (text
fields and histogram).
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2. Structure of File

General Information

File contains parameter settings. Each record begins with a new
line and has prescribed format.

Settings are grouped into 11 sections. Every section contains a
group of records with settings of the same type.
The first line of every section must have the following format
(section name):
[Name],

where Name is a specified section name. Square brackets are
obligatory here.

88

Important:

Sections have fixed names. Stick to required register to record
names, differentiate capitals and small letters.
Sections in the settings file and records of sections may be put
in a free order.
The sections are described below.
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Section
name

Description of settings file sections

Purpose

Format of records in section

General Configuration of general settings.

Parameter name = Value,

where:

Parameter name is the name of the

Line 1
Line 2
Line 3
Line 4
Line 5
Line 6
Line 7
Line 8

Configuration of telephone lines with
corresponded numbers.

Text

Configuration of text objects content.

Object name = Substitution string,

Bar

Configuration of graphic objects type.

Object name is the name of the region

parameter that is being configured;
Value is a text or numeral value of
parameter.
For more detail see the table in the
corresponded section.

where:

(picture template) object that is
being configured;
Substitution string is the line with tags
containing values (text to be placed).
For more detail see the table in the
corresponded section.

3. Working with Settings File
Settings file is created and edited in any text editor, e.g.
Notepad.
This file is created to define type, functioning of the main
application window control elements, to configure data
collecting and picture generating in the SLTelephone
application.
Settings are read from the file when:
●● the application is launched;
●● the settings file is loaded in the application;
●● pressing the Refresh button located in the main
application window. Depending on the mode of work
(configuring or voting) either all settings or its part
will be read.
Select and load settings file in the Settings... window. This
window can be opened via:
●● the Settings... command in the program context menu;
●● the Settings... button in the main application window.
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Тable 1.

Configuring Parameters
1. General Section
The General section contains service settings and general
parameters. It has lines of the following format:
Parameter name = Value,

where:

is the name of the parameter that is
being configured;
●● Value is a text or numerical value of parameter.

Description of the section is given below.

Table 2.
Name

Parameters of the general section
Necessary Description

Possible Values

Output

+

Name of target graphic file.

This is a full path to the file or
a path relatively settings file.
The file automatically receives
the result.tga name if the value
of this parameter is absent.

Region

+

Name of region file (file with
picture template).

This is a full or a relative path
to the file.

Location of statistics file.

- URL if the file is on site;
- full path to the file on local
disc.

FromUrl

Logdir

+

Name of the folder with log
files.

This is a full path to the folder
where log file and vote results
will be located. If the value
of this parameter is absent a
folder with settings file will be
selected automatically.

Timeout

+

Time (in seconds) specifies
period of target file update.

Integer, 1 – 10.

Barsize

+

Value is used for normalizing Integer, 1 – 30000.
when calculating a hight of
histogram bar.
It is used if the Bar4all
parameter is 0.

Bar4all

+

Method of normalizing for
calculating bar height (see
note).

1 – normalizing to total
number of votes;
0 – normalizing to maximal
number of votes depending on
answers.
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●● Parameter name

Name

ProcFormat

Necessary Description

+

Decimal place in percent.

Possible Values

Integer, 0 – 18.

Increment step for all
answers that are not
purposely configured.
The parameter is used to
configure main window
buttons intended for
increasing/decreasing of
votes number manually.

Integer, 1 – 100.

CallsBigStepN,
where N

Increment step for specified
answer.

Integer, 1 – 100.

Question

Text of the question
displayed in the text field
of the main application
window.

Text string.

VariantN,
where N is

Text displayed in the caption Text string.
of the Variant N... main
window elements group. The
group corresponds to the
specified answer.

CallsBigStep

is answer
number
(1–8).

the number
of answer
version (1–8).

+

Configuring Parameters

Parameters for configuring of the main window elements
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2. Text Section
The section contains configurations of the target image text.
The section has lines of the following format:
Object name = Text string,

where:

is the name of text region object that is
being configured;
●● Text string is the string used for generating of text
that is displayed in output image in text object with
specified name. The string may contain several
substrings with free text or substitution strings (see
the table below).

Substitution strings are tags with variable names. The
application automatically estimates variable values for definite
time. A text with current variable values will be put in text field
when the image is being generated.

Table 3.

Text fields of the Text section

№

Substring

Outcome

1

Free text

Free text.

Tags: <# AN>, where A is variable name; N is answer version (1–8)
2

<#countN>

Integer that indicates the quantity of votes for specified
answer with N index.

3

<#procN>

Real number that indicates a quantity of votes for
specified answer with the N index in percent.

4

<#variantN>

Value of the Variant N parameter. This is the text in the
VariantN line (General section of the settings file).

5

<#question>

Value of the Question parameter. This is the text in the
Question line of the General section.

6

<#all>

Real number that indicates a total number of received
votes.
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●● Object name

 Example:

Line of the following type:
Answer1 = <#variant1>

This indication means that the following information should be
entered in the Answer1 text field: text of the answer assigned as
the value of the Variant1 variable in the General section.
Line of the following type:
This indication means that the following information should be
entered in the Value1 text field in the following order:
●● number of votes for the first answer when the picture
is being updated;
●● space, dash, space;
●● number of votes for the first version in percent;
●● the % symbol.

3. Bar Section
The Bar section contains records for configuring of histogram in
the target picture.
One record contains settings of one histogram bar:
●● bar orientation (horizontally/vertically);
●● the way the bar is completed (bottom-up/top-down
for vertical objects), (left-to-right/right-to-left for
horizontal objects);
●● answer to which corresponds a bar of histogram.
One histogram bar corresponds to one rectangle of the region
(picture template).
Lines in this section have the following format:
Object name = <#UYV>,

where:

is the name of a corresponded graphic
object in the region;
●● <#UYV> string is a tag where the U, Y, V symbols are
replaced by required parameter values (see the table
below).
●● Object name
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Value1=<#count1> – (<#proc1>)%

Tag attributes of the Bar section

Attribute

Description

Possible values

U

Orientation of graphic object.

h is horizontally;
v is vertically.

Y

Direction of bar completing. Possible values
depend on graphic object orientation.

For the h type:
t is bottom-up;
b is top-down.
For the v type:
l is left-to-right;
r is right-to-left.

V

Number of corresponded answer version.

1–8

Example:

Let there are 3 graphic rectangle objects for 3 answer versions
in the region:
●● Bar1 coresponds to the first version;
●● Bar2 corresponds to the second version;
●● Bar3 corresponds to the third version.

It is necessary to configure parameters so that bars in output
image are completed bottom-up. In this case records in the Bar
section of the settings file should have the following form:

In this case a histogram will be the following:
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Table 4.

4. Line Sections
The Line1 – Line8 sections are intended for configuring
parameters of telephone lines. Every line has its own section
with the LineN name, where N corresponds to the line number.
Settings file may contain 1 – 8 line sections, at least one for
every used line.

Configuring Parameters

The following parameters can be configured for every line:
●● enabling/disabling of line use;
●● number of answer where calls via the given line are
received;
●● factor for votes calculating;
●● message received by abonents via Liner-8 (in case if
this device is used as data source).
The Line1–Line8 sections contain lines of the following format:
Parameter name = Value,

where:
●● Parameter name

is a name of parameter that is being

configured;
is a text or a numeral value of parameter.

●● Value

Detailed information on parameters is given below.

Table 5.
Name

Line parameters group

Obligatory

Description

Possible values

Use

+

Enable to use line.

Integer:
1 denotes enabling;
0 denotes disabling.

Factor

+

Factor for calculating votes
received via given line with 0.1
accuracy.

Real number:

Variant

+

Version number where line is
assigned.

Integer:

Audio file name. This file will
be played back in response to
abonents if Liner-8 is used (for
more information on this device,
see documentation).

Full or relative path to audio
file.
Only non compressed WAV
files (16 bit) are supported.

Sound

0.0–100.0

1–8
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General Information
SLTelephone does not require specific configuration of logging.
It is kept all the time automatically.
Logging starts automatically with the application and is
stopped when the application is closed.
Information on work is logged in files with standard names.
Location of log files can be indicated by the user in the settings
file via the Logs parameter in the General section.
There are 2 types of log files:
1. Files with voting results.
2. Report file is the file with a report on all program operations
from the moment of its launch and till its stopping.
These files can be opened with any text editor, e.g. Notepad.
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Logging

Resulting File of Voting
1. Files Content and Procedure of Its Creation

The file is created when collecting of data and picture
generating is started, i.e. when the Start button is pressed. This
button is located in the main application window. The file is
updated periodically. When the Stop button is pressed recording
into this file is stopped.
If recording is restarted (the Start button is pressed again) one
more file with voting results will be created.
During one application session several log files with voting
results can be created. Beginning of data record can be defined
according to log files names.

2. File Name
Resulting file has the following name:
Result_Date_Time.SLPhoneLog,

where:

is a necessary subline that specify that the file is
of a result type;
●● Date is the date of file creating in the YYYY_MM_DD
format, where:
●● YYYY denotes a year;
●● MM denotes a month;
●● DD denotes a date;
●● Time is the time of file creating in the hh_mm_ss
format, where:
●● hh are hours;
●● mm are minutes;
●● ss are seconds;
●● SLPhoneLog is the extension of log files in the
SLTelephone application.
●● Result
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Resulting log file contains information on number of votes
received for every answer (absolute number and in percent) and
on total number of votes.

3. Example
This is the example of a resulting file opened with Notepad.

2

1

3

Configuring Parameters

 Example:

4

Time of file creating is displayed in its name (1).
The file contains information on votes number received from the
beginning of file creation till its closing. Data is given for every
answer version in standard format (2) and in percent (3). Also,
total number of votes is indicated (4).
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Report File
1. File Content and Procedure of Its Creation
Log file contains information on all program operations
executed from its launch until its exiting. Every record contains
date, time and brief description of the event.

Report file is creating when the application is launched.
Information stops being recorded into the report file when the
application is closed.

2. File Name
Report file has the following name:
Report_Date_Time.SLPhoneLog,

where:

is a necessary substring that specify that the
file is of a report type;
●● Date is the date of file creating in the YYYY_MM_DD format,
where:
●● YYYY is a year;
●● MM is a month;
●● DD is a date;
●● Time is the time when report file was created in the hh_mm_ss
format, where:
●● hh are hours;
●● mm are minutes;
●● ss are seconds;
●● SLPhoneLog is the extension of log files in the
SLTelephone application.
●● Report
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The following events are recorded: application launch,
application exit, selection of settings file, receiving of calls,
voting start/stop/restart and information on errors.

3. Example
This is the example of a report file opened with Notepad.

Report File

 Example:

Time of file creating is displayed in its name. The file contains
information on implemented program operations. Time and
date of their implementation are also indicated in the title.
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Work Modes. Program Icon

Program Interface

Work Modes. Program Icon
1. Work Modes
There are 2 modes of the SLTelephone application work:
●● configuration mode when user selects and loads
settings file;
●● voting mode when information on voting is collected
and output picture is generated.
The application is always launched in configuration mode.
Toggling between modes is made via buttons of the main
application window.

2. Program Icon
When the application is launched its icon appears on taskbar in
the form of telephone.

Program icon displays current application state:
●●
denotes that the application is in configuration
mode;
●●
denotes that the application is in configuration
mode. Settings file with wrong parameters is loaded,
e.g. incorrect path to the file with statistics is
indicated. Pointing the icon by the cursor a pop-up
menu with information on mistake appears;
●●
denotes that the application is in voting mode.
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3. Icon Context Menu

It contains application commands. Description of commands is
given below.

Table 1.

Commands

Command

Purpose

Start

The command is used to switch voting mode on.

Stop

The command is used to switch voting mode off.

Refresh

The command is used to update application settings. In this case
settings from current settings file will be reloaded. Only current
factor values will be updated if voting mode is switched on. If the
mode is switched off all settings will be taken from the file again and
voting results will be reset.

Main Window...

The command is used to open main program window.

Settings...

The command is used to open window with application settings.

Shortcuts...

The command is used to open window for shortcuts configuration.

License Settings...

The command is used to open license settings.

About
SLTelephone...

The command is used to open the window with detailed information
on the application.

Exit

The command is used to exit the application.
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Open icon context menu by right-clicking program icon.

Application Launch
Application is launched when the following file is started:
~\Plugins\SLTelephone\SLTelephone.exe,
where ~ denotes a full path to the folder where the
ForwardT Software is installed.

When the application is launched its icon appears on the toolbar
in the form of a telephone. At first launching a note on the
necessity of selecting settings file appears.

Right-click program icon (1). Then select Settings...(2) in context
menu to specify configuration file.

2

1

The Settings window appears. Select settings file by clicking
Browse... in this window.
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Use either the shortcut or the Start Menu command to launch the
application: All Programs>ForwardT Software>Plugins>Telephone

Main Application Window
1. Overview
The main application window is used for configuring and
starting of voting.

Configuring Parameters

1

2

3

4
5

6

7

Title bar displays application title, its current state and name of
active settings file.
The main application window contains the following groups of
control elements:
●● text field (1) where service information is displayed.
This is the value of the Question parameter.
●● groups of elements to work with telephone lines (2):
●● the Show line calls and factors check box used for
displaying/hiding of the Line calls and Line factors
groups. Elements will be displayed in the main
window if the check mark is set;
●● Line calls are text fields for displaying of actual
number of received calls;
●● Line factors are text fields for displaying and
adjusting current line factors;
●● elements of the Variant group (3) are used for displaying
of voting and for controlling votes number manually;
●● the Settings... button (4) is used to open the window for
selecting of a settings file and language;
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buttons for controlling voting procedure:
●● Start/Stop (5) are used to turn on/off voting mode;
●● Refresh (6) is used to update settings;
●● Exit (7) is used to exit the application.
●●

2. Line Calls Group
The Line Calls group is used to display information on received
calls.

3. Line Factors Group
Line factors group of control elements contains descrete text
fields for line factors adjusting. Fields titles correspond with
line numbers.
Factors are used for votes calculating. Number of received
votes from specific line is a product of votes number on line and
specified factor.
Original factors values for every line are specified in settings
file. Values can be edited in corresponded fields when voting is
being implemented.
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Main Application Window

The group has text fields. Each field corresponds to telephone
line. Field names correspond with lines numbers. Fields display
number of received calls. Maximal number of calls is 8. Lines
are assigned in settings file.

4. Variant Group
Variant group of elements is used for displaying voting according

to offered answer versions.

Number of Variant groups displayed in the main application
window corresponds with the number of answer versions for
which telephone lines are assigned. These settings are specified
in settings file in the Line section.
Title of every group contains a string of the following format:
Variant N (LN1, LN2,...): Text_str,

where:

denotes answer version;
are indices of lines where votes for specified
versions are received;
●● Text_str is a service information with indicated index.
This is a text string that is a value of the VariantN
parameter, the General section. The text is used only in
the main application window and it may not obligatory
match the answer text displayed on the screen.
●● LN1, LN2,...

Example: Version 3 (3, 4, 5): No.
1

2

Every Variant group contains the following elements:
●● indicators of voting for the given answer (1):
●● graphic indicator displays voting accumulation;
●● number of votes for version in percent;
●● number in brackets is an absolute votes number
for answer;
●● buttons for varying a number of votes for specific
variant manually (2):
●● +1 and -1 denote adding and taking away of 1 vote
correspondingly;
●● +x and -x denote adding and taking away of x votes
correspondingly, where х is an increment step
specified in settings file (values of the CallsBigStep
and CallsBigStepN in the General section).

44

Main Application Window

●● N

5. Functioning and Appearance of Controls
Properties of main application window elements depend on
parameters values specified in settings file:
●● text of the question in the text field (1);
●● Variant... group quantity and its features:
●● group title (2);
●● increment step assigned to buttons (3).
The Settings window is used for selecting a settings file. It can be
opened by clicking Settings.
If settings file was changed it would be updated after clicking

Main Application Window

Refresh.

1

1

3
2
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Settings Window
The Settings window is opened via the Settings... button located in
the main application window.

2

1

4

The following controlling elements are in this window:
●● elements for settings file selecting (1):
●● text field where a path to the settings file is
displayed;
●● the Browse... button to open the window in order to
select a necessary file (2);
●● the Language drop-down list for selecting application
language;
●● the OK (3) button for applying the settings and for
closing the window;
●● the Cancel (4) button for closing the window without
any changes.

46

Settings Window

3

Shortcuts Customizing
You may customize shortcuts for entering vote results manually
in the Shortcut onfiguration... window.

1. Shortcut Configuration Window
The Keyboard Shortcuts... command is used to open the Shortcut
Configuration window. This command can be activated via context
menu of the program icon or via system menu of the main
application window.

2
3

Shortcuts Customizing

4
5
1

6

7

The window has the following control elements:
●● correspondence table (1) to display commands for
variations of votes number and shortcuts assigned to
them;
●● elements for editing of shortcuts list:
●● text field (2) for assigning keys combination. Set
the cursor in this text field and press necessary
buttons to enter a combination of keys that you
want to assign;
●● the Assign button (3) for assigning a combination of
keys specified in text field to the command selected
in the correspondence table;
●● the Clear button (4) is used to remove shortcut
selected in the table;
●● the Clear all button (5) is used to remove all
assigned shortcuts;
●● the OK button (6) is used for accepting all settings;
●● the Cancel button (7) for closing the window without
applting of settings.
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2. Shortcuts Assigning
Complete the following steps to assign shortcuts:
1. Select a line with configured command in the table.
2. Set a cursor in the field and press a desirable combination of
keys.
3.

Click Assign.

2

1

3

4. Assigned combination appears in the Hotkey column.

Shortcuts Customizing

5. Repeat steps 1–3 as many times as it is necessary.
6. Click OK to apply the settings and to close the window.

4

6
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General Information
This section contains a description of outputting on air of voting
data via the SLTelephone application.
Let us take the example included in the SLTelephone
application package. The example is located in the
~\Plugins\SLTelephone\Sample folder, where ~ denotes a full path to
the folder where the ForwardT Software is installed.

gg

Tip: It is recommended to use files of this example while learning as
models.

1. Survey Data
Let it is necessary to conduct a survey answering the following
question: ''Have you ever been to Siberia?''. Several answers
are proposed: «Yes», «No», «Spend every summer». There is
a specified line with corresponded phone numbers for every
answer: 555-11-11, 555-22-22, 555-22-33.
The following information on voting should be output on air:
1. Initial data, i.e. question, answers and phone numbers.
2. Indicators of voting procedure:
●● number of votes for every answer (both absolute value
and in percent);
●● total number of people who voted;
●● histogram with votes distribution according to
answers.
Votes are received via Liner-8 (dataphone adapter used for
interactive voting).
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General Workflow

2. Operating Procedure
Operating procedure includes the following steps:
1. Creation of a region in the Forward Titling application.
2. Creation of a settings file for the SLTelephone application.
3. Plugging of data source (dataphone Liner-8).
4. Configuration of the SLTelephone application.

General Information

5. Preparation of a title project in the FDTitle Designer
application.
6. Test voting.
7. Configuration of the FDOnAir application.
8. Start of telephone voting on air.
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Step 1. Creation of a Region
Region is created via the Forward Titling application (detailed
information on this application is in the ''ForwardTitling:
Graphic Editor. User's Guide'').

1. General Workflow
1. Launch Forward Titling (1) via application shortcut.
Click Create new region (2) in the Welcome to Forward Titling
dialog. Click OK.

Configuring Parameters

2
1

2

3. Give the name to the region in the New region window. This
name will be file name, voting_VertBars (3) in our example.
Specify region size (4) and click OK. Region file will be
opened.

3

4
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4. Set background properties (4) via the Background image... and
Background color... commands of the context region menu. The
menu is opened by right-clicking any place of the region.

Configuring Parameters

4

5. Background will be modified according to the settings. A
semitransparent figure (5) is a background image in our
example.

5

6. Add text objects (Text box) for displaying of text information
and numbers voting results in the form of a region. There
are 15 objects in our example:
●● (6) is the object for text of the question;
●● (7) are objects for text of answers;
●● (8) are objects for telephone numbers;
●● (9) are objects for displaying of votes quantity
distributed according to answers;
●● (10) are objects for displaying of votes quantity in
percent;
●● (11) is the object for displaying of total votes number;
●● (12) is the object for displying the Total votes text.
7. Add graphic objects for graphic representation of votes
distribution according to answers. Three rectangles (Rectangle) are in our example. These rectangles are bars of a
histogram (13).
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13

3

12

6
7

11

9

8

8. Save all region modifications via the command of the main
application menu: File > Save region.
9. Quit the application.
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10

2. Adding of Text Object
Complete the following steps to add a text object:
1. Right-click the region.

1

3. Move the cursor to the position on the project field where
you want to place an object (2). Left-click and drag the
cursor diagonally with the left button pressed. Then release
the button.
4. Give the name to the text object. To do so open a context
menu by right-clicking one of region borders. Select Properties.... (3).

2

3

54

Configuring Parameters

2. Select New Object > Text box (1) in the menu.

5. Enter necessary name in the the Name text field of the
Object Properties window, Question (4) in our example. This
name will be used in the setting file for configuring of text
substitution in this object. Click OK (5) to apply the settings
and to close the window.

Configuring Parameters

4

5

6. Type necessary text in text box (6).
7. Configure necessary text design by selecting required font
and effects via Font and Effects List... (7) commands.

6

7
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3. Adding of Graphic Objects
Complete the follwong steps to add graphic objects:
1. Right-click the region.
2. Select New Object > Rectangle (1) in the menu.

3. Move the cursor to the position on the project field where
you want to place an object (2). Left-click and drag the
cursor diagonally with the left button pressed. Then release
the button.
4. Specify a name to the graphic object. To do so open a context
menu by right-clicking one of region bounds. Select Properties... (3).

2

3
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1

5. Enter necessary name in the Name text field of the Object
Properties window. The name will be used in the settings file
for histogram configuring, Bar1 (4) in our example.
Click OK (5) to apply the settings and to close the window.

Configuring Parameters

4

5

6. Configure design of a graphic object by selecting filling (6)
via the Effects List... command (7).

6

7
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Step 2. Creation of Settings File
1. Creation of settings file
You may create a settings file in any text editor, e.g. Notepad.
1. Open Notepad.

Step 2. Creation of Settings File

2. Save an empty file with the SLPhoneProj extension,
Voting_VertBars.SLPhoneProj (1) in our example. We
recommend to save the file in the same folder where the
region file is located.

1

3. Add necessary settings in the file in required format.

88

gg

Important:

Remember that all file records are grouped into sections with
fixed names.

Tip: It is recommended to copy a content of the example file (voting_
VertBars.SLPhoneProj) and configure it according to your
needs.

4. Save edited file.
5. Exit the application.
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2. The General Section
Configure service and general parameters in General section.

1
2
4

3

6

7

8
9

1. Name of output graphic file. The file will be saved in the
same folder where the settings file is located if only its name
is specified, voting_VertBars.tga in our example.
2. Region file name, voting_VertBars.rgn in our example.
3. Path to the folder where log files are recorded, Logs in our
example.
4. Time of image updating, 2 seconds in our example.
5. Way of normalizing for calculating of a histogram bar
height, 1 in our example (normalizing according to total
votes number).
6. Decimal place that display number of calls in percent, 0 in
our example.
7. Increment step assigned to buttons of the main application
window, 15 in our example.
8. Service information, Have you ever been to Siberia? in our
example.
9. Text of answers that are displayed in the main application
window, -Spend every summer,-Yes, -No in our example.
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Step 2. Creation of Settings File

5

3. The Text Section
Configure text parameters. This text will be placed in output
image.
Important :

This section deals with names of text objects specified for the
region in use (see the section Step 1. Creation of a region).

Step 2. Creation of Settings File

88

1
2
3
4
5
6

1. Question that will be put in the Question text object, Have you
ever been to Siberia? in our example.
2. Answer1, Answer2, Answer3. Enter text of answers that will be
put in text objects with these names: -Spend every, -Yes, -No
are in our exmaple.
3. Enter the <#all> tag for the All object. It denotes a total
number of received votes. The SLTelephone application
will calculate votes and will put its number in the object
automatically.
4. Tel1, Tel2, Tel3. Enter phone numbers that will be placed in
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text objects with identical region names, 555-11-11, 555-22-22,
555-22-33 in our example.
5. Value1, Value2, Value3. Add <#count1>, <#count2>, <#count3>
tags correspondingly. As the result tags will be substituted
by number of votes for every answer.
6. Percent1, Percent2, Percent3. Add <#proc1>%, <#proc2>%,
<proc3>% tags correspondingly. As the result tags will be
substituted by number of votes for every answer in percent.

4. The Bar Section

Step 2. Creation of Settings File

Configure histogram parameters.

1

1. Bar1, Bar2, Bar3. Add <#vb1>, <#vb2>, <#vb3> tags
correspondingly.
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5. The Line Sections
Configure parameters of telephone lines.
Three lines are used in our example:
Line 1, Line 2, Line 3. Sections: [Line1], [Line2], [Line3].

1
4

3

Step 2. Creation of Settings File

2

Implement the following in every section:
1. Enable using of telephone line by entering the value 1.
2. Correspond telephone line to answer, Line1 is the first
answer, Line2 is the second and Line3 is the third in our
example. Number of line is identical to number of the
section.
3. Specify the name of audio message for abonents that is
received from specified line, 1.wav, 2.wav, 3.wav in our
example.
4. Specify factor for votes calculating.
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Step 4. Configuring of the SLTelephone Application
1. Launch the SLTelephone application via program shortcut.
2. When the application is launched its icon will appear on
the toolbar in the form of a telephone. At first launching
appears a note on the necessity of selecting settings file.
3. Open icon context menu by right-clicking program icon (1).

Step 4. Configuring of Application

1

4. Select Settings... (2).

2

5. Click Browse... (3) in the appeared window.

3

63

6. Select a folder and file with application settings created on
the 2 step in the Open window, voting_VertBars.SLPhoneProj in
our example.
7. Click Open (5).

Step 4. Configuring of Application

4

5

8. Click OK (6) to apply the settings and to close the Settings
window.

6

9. Main application window appears.

10. Click Start (7) to create a test image. The image is based on a
template (region file specified in the settings file). Click Stop
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7

11. TGA file with specified name appears in the folder specified
in the settings file, voting_VertBars.tga in our example. The file
contains the image (8) based on a template and results of
voting (zero values are at the moment).

8
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Step 4. Configuring of Application

to switch from the voting mode.

Step 5. Creating of a Project in the FDTitleDesigner Application
Create a project in the FDTitle Designer application. Add the
Picture title element to the project. Generated on the fourth step
TGA file is the task for the Picture title element.
1. Launch the FDTitle Designer application via program
shortcut.
Add title element to the project. To add:
2. Move a cursor to the Element Types tab.
3. Drop-down panel appears. Select the Picture type by leftclicking.

Step 5. Creating of a Project...

1
2

3
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4

Configure parameters of the title element:
5. Double-clicking the title element to open the window and to
select the task.
6. Select necessary file in the appeared window. The file must
be a TGA file created via the SLTelephone application on
the fourth step, voting_VertBars.tga in our example.

6
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Step 5. Creating of a Project...

4. Move the cursor to the project area there where you wish
to locate the element. Left-clicking and then holding the
button move the cursor diagonally. Release the button.

7. Select the way of stretching in the Stretch drop-down list of
the Properties panel, e.g. Keep AspectRatio. In this case the
image will be proportionally minimized to the title element
size.

Step 5. Creating of a Project...

7

8. Save the project in the file via File > Save As... .

8
9. Select a folder in the appeared window and type file name.
Click Save.

9
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Step 6. Test Voting
1. Start preview in the FDTitle Designer application by
clicking the Start Preview button (1).

Step 6. Test Voting

1

2. In the SLTelephone application window:
1. Click Start (2).
2. Add votes (3) for every variant via buttons.

3

2
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3. All changes (4) will be displayed in the FDTitle Designer
application window.

4

5

Step 6. Test Voting

4. Do the following in the main application window:
1. Click Stop (5).
2. Click Refresh (6) to reset voting results.

6
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Step 7. Configuration of the FDOnAir Application
Configure necessary FDOnAir settings to output voting results
on air.
Launch the FDOnAir application via desktop shortcut. Create a
schedule.
1. Click Settings... in the main application window.

Step 7. Configuration of Application

1

2. Select the Title objects tab in this window.
3. Load title project by clicking the Title project button.

2
3
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4. Select the project file, voting_VertBars.SLTitleProj in our
example.
5. Click Open.

4

5

6. A full path to the project file will be displayed in text field.

Step 7. Configuration of Application

7. The F9 button is automatically assigned for controlling title
object of the loaded project.
8. Close the Settings... window by clicking Close.

6

7

8

9. Object and task names will be displayed on the F9 button in
the main window.
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Step 8. Launch of Voting Procedure
1. Click Start (1) to switch the application to voting mode.

1

Step 8. Launch of Voting Procedure

2. Start the schedule (2) for execution in the FDOnAir
application and turn titles displaying on (3).

3

2
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3. The image with results of voting will be displayed on the
output video image. The image will be updated in periods
specified in the settings file.

1.

Step 8. Launch of Voting Procedure

2.

3
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Additional Information

Compatibility of the SLTelephone Plugin with Other Software From the
ForwardT Product Line
The SLTelephone plugin is a program software used in complex
with the ForwardT software.
The table below contains the information on products of the
ForwardT product line compatable with the SLTelephone
plugin.
Purpose

Necessity of
FDOnAir

Forward T

Video and sound input/output and non-linear cutting.

Forward TA

Broadcast automation according to the schedule with a
possibility of controlling in real time.

p

Forward TP

Server for TV signal delay with a possibility of
rebroadcast rescheduling.

p

Forward TP2

Server for TV signal delay with a possibility of
rebroadcast rescheduling (2 channels of data input).

p

Forward TK

Color substitution (rear screen) of a high quality and
non-linear cutting.

Forward TT

Multi-layer titles overlay over video according to the
schedule and control over it in real time.

p

Without board

Work of software without FD300.

p

Additional Information

Software
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Useful links
ForwardT Software set: description, download, documentation, solutions
http://www.softlab-nsk.com/forward/index.html
http://www.softlab-nsk.com/forward/plugins.html

Support
Useful Links

e-mail: forward@sl.iae.nsk.su
forward@softlab-nsk.com
forward@softlab.tv

Forums
http://www.softlab-nsk.com/forum (currently available in Russian only)

Translation from
November 24, 2010
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